Intermediate Lab
PHYS 3870

CONVEYIMG INFORMATION

Gathering Information
An Exercise in DataThief, Plotting and Curve Fitting
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Introduction to Scientific Computing
PHYS 2500

An Exercise In Data Analysis

» Use DataThief to “steal” data from the graph in DennisoninFreefall.jpg and
save the data in the file YOURNAMEInFreefall.txt:

» In your favorite plotting and curve fitting program:
* Import the data from DennisoninFreefall.jpg stored in YOURNAMEInFreefall.txt
* Import the data from FreefallLab.txt

» Create a single graph of position vs time with:
» Data points and error bars from FreefallLab.txt
» Data points (the slacker has no error estimates here!) from DennisoninFreefall.jpg
« A mathematical model for free fall plotted as a line
+ List your best estimates for values and errors for you model fitting parameters

« BONUS:

* Lineraize your model, that is plot the dependant variable versus some function (e.g., square, square root) of the
dependant variable such that the plot yields a straight line

* Plot both data sets (with appropriate errors) and your linear model on a linearized graph

» Do an automated fit with your linear model to the FreefallLab data. List your best estimates of the slope and
intercept (with errors) and from these the best estimates (with errors) for you original model fitting parameters.
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Data for An Exercise In Data Analysis

Freefall.txt
DennisoninFreefall.jpg

time(s) disp({m) error{m)
0 -137.5 145.9
3 0.06667 -157.6 145.2
o 0.1333 81.61 152.4
. 1.3=10 ' ' ' 0.2 62.14 151.9
= 0.2667 30.93 150.9
= 5 q 0.3333 81.17 152.4
2, 1x=10°F ¢ * 0.4 -12.04 149.6
- * 0.4667 258.4 157.8
= 0.5333  334.6 160
o L 0.6 398.2 161.9
= 5001 * & - 0.6667 218.3 156.5
= 0.7333 202.9 156.1
o * 0.8 524.1 165.7
[ > 0.8667 516.4 165.5
L o - 0.9333  268.2 161
.= p 1 672 170.2
3 1.067 527.9 165.8
| | | 1.133  656.7 169.7
— 500 1.2 1018 180.5
0 0.5 1 1.5 2 1.267 1004 180.1
1.333 1029 180.9
1.4 1128 183.8
: 1.467 1234 187
tme {5} 1.533 1412 192.4
1.6 1489 194.7
1.667 1264 190.9
1.733 1521 195.6
1.8 1049  208.5
1.867 2031  210.9
1.933 2016 210.5
2 2222  216.6

UtahState ISECEE S WRITING REPORTS Lecture 6 Slide 3

UNIVERSITY Fall 2015




Results for An Exercise In Data Analysis

3x10°

—— Freefall model
*##® DennisonlnFreefall Data
ooo Freefalll.ab Data

210°

1x10°

displacement (cm)

— 1x10° ' ' '
o | |
time (s)

Model is y(t)=(1/2)at2 + v t +y,
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Intermediate Lab
PHYS 3870

CONVEYIMG INFORMATION

Analyzing and Plotting Data with Mathcad

References:
PHYS 3870 Web Site
USU Library Class Web Site
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PHYS 2500 Introduction to Scientific Computing
Mathcad Tutorials
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PHYS 2500 Introduction to Scientific Computing
Mathcad Tutorials

E \PSTONE MATHCAD PROJECT
Chapter Table of Contents

. 10.1 Capstone Project-Observation of Planets in Our Galax
Summaries Preface to the First Edition E H ch.g
Pro he S 4Ed i. ARRAYS AND 3D GRAPHING 10.1.1 Relevant Equations
reface to the Secon ition Ch.B :
6.1 Tutorial 10.1.2 Most Recent Information on Exoplanets
Preface to the Third Edition .
6.2 Exercises 10.2_Resources for Scientific Reports
About the Authors
. . 6.3 Problems 10.2.1 Searching Bibliographic Databases--Google Scholar
Installation of the Handbook Files
Software Used in the Handbook 6.4 Additional Matrix Operations 10.2.2 Organizing Bibliographic Materials--EndNote Web
6.5 Vector Field and Contour Plots iei i
1. INTRODUCTION TO SCIENTIFIC COMPUTING # 10.2.3 Data Acquisiton for References--DataThief
E ti i
1.0 Overview of Software for Scientific Computing valuation torm Evaluation Form
ch.1
1.1 Mathcad Survival Skill j
ahicac ot S E . SYMBOLIC PROCESSING AND NUMERICAL ANALYSIS Course Evaluation Form
1.2 Mathcad Worksheet Management
Ch.7 7.1 Tutorial
E 2. MATHCAD BASICS 1.2 Exercises TA ACQUISITION AND ANALYSIS
o 2.1 Tutorial 1.3 Problems E 11.1_Introduction to Data Acquisition and Analysis Exercises
) 2.2 Exercises Ch.4 . . .
23 Probl 1.4 Exercise: Working with Complex Numbers Data Acquisition with Data Studio
£ Croblems 15 E ise: Finding Ei | 4 Figenfuncti 11.2 Data Studio Multimedia Tutorial
: .3 Exercise: Finding Eigenvalues and Figenfunctions
Evaluation Form 11.3 Data Studio Analog Interface Tutorial
Evaluation Form o .
11.4 Data Studio Digital Interface Tutorial
E 3. VARIABLES AND UNITS OF MEASUREMENT E 11.5 Data Studio Digital Sequence and Control Tutorial
= 3.1 Tutorial 5. DATA ANALYSIS: Descriptive Statistics and Linear Regressi Data Acquisition with Science Workshop
. . ch. &
3.2 Exercises 8.1 Tutorial 11.6_Science Workshop Tutorial
W . 8.2 Exercises 11.6.1_Science Workshop—-Example Reports
.4 Supplemental Exercises iciti i i
8.3 Problems Data Acquisition with Labview
3.5 Supplemental Problems Evaluation Form 11.7 Introduction to Data Acquisition with [ abview
Evaluation Form - 11.8 Mathcad-Labview Interface Tutorial
E 4. SOLVING EQUATIONS E 11.9 Labview-Mathcad Interface Tutorial
= 4.1 Tutorial o ). DATA ANALYSIS II: Nonlinear Curve Fitting Data Analysis of Measured Data
4.2 Exercises )
43 Problems w 11.10_Data Analysis with Mathcad
Evaluation Form 9.2 Exercises 11.11_Data Analysis with Excel
9.3 Problems 11.12 Data Analysis with Matlab
5. GRAPHING .
E 51 Tuorial 9.4 Residual Plots Evaluation Form
Ch.5 Evaluation Form

5.2 Exercises Course Evaluation Form
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Intermediate Lab
PHYS 3870

CONVEYIMG INFORMATION

Analyzing and Plotting Data with Excel

References:
PHYS 3870 Web Site
USU Library Class Web Site

\
‘L Microsoft
< EXxcel
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Instructions for an Excel Tutorial Exercise

Instruction for Data Analysis with EXCEL

Overview of Excel Spreadsheets

Follow the
detailed (if
boring)
instructions
to create an
Excel
worksheet to

We begin by reviewing some basic concepts for spreadsheet programs. starting from the full program and gradually
zooming in to the details. But first, open the Excel Workbook file named “Excel Data Analysis™ and save your
Workbook with a new name by selecting File>Save As from the Menu Bar and giving the file the name
“Your Last Name-Excel Data Analysis™.

Cell

Reference

5] Microsar_‘t Exceil - Workbook Name

Standard
Toolbar

Menu
Bar

Workbook
Name

Title
Bar

Formatting
Toolbar

e Edit Wiew Insert Format Tools  Data B Type a question for help - _ 8 x
analyze and 5 ol s v Bz pdEEE S % o w|E -0 A- B
plot a sam ple P ¥ ) S E A A | @ B (| ¥ Renly with Changes... End Review.., !
Columns —L % a1 - A =A3+EBAy
data set and | Al B | ¢ [ ON] E [ F 6 [ A ] 5
1 0 —
prepare a Rows EN
simple v
b
rep (@] rt . 4 (3 [\Wurksheej Name ; She heets / £ | » |J
Regtly r \
/ / Ny ~/
Active Cell Worksheet Name Worksheet Tabs Formula Bar Scroll Bars

Figure 1 shows a screen shot of an Excel Workbook file and identifies the key components.
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|
Report from an Excel Tutorial Exercise

PHYS 2500 EXCEL DATA ANALYSIS PROJECT REPORT Name:  Enter name here
Date: Enter current date here

Experiment Description
Add a paragraph describing the experiment performed.

05 ¢ Spring Motion
045 F
Follow the s b
B : Summary of Results TE
d etal | ed (If Add a paragraph describing the results of your experiment. E 0.35 _
. ¥ 03f
boring) E Tl
g 025 ¢ O N ... . # ... .0
. . ] F
Instructions L Py
g
0.15
to Create an Summary of Fit E
L S E I e 01t
Excel 00s |
gk
WorkSheet to o o5 1 15 ] 25 3 1 4 45
Elapsed Time (s)
an alyze and Fitting Function )
y(t)=A*sin(w*t+8}+yo —#—Data Fit------ Offset
plot a sample
Fitting Parameters Residual Graph
Parameter Symbol  Value Units 0.008 ¢
d ata S et an d Amplitude A 0.0715 m ; 0006 F
Angular frequency W 3.9026 Hz ’
p I’epal’e a Phase [ -0.21 § 0.004
S i m | e Offset yo 02412 m E :E,G-D{D E
p Goodness of Fit E 0
WNumber of Data Points 41 2 -0.002
rep 0 rt . Mumber of Fitting Farameters 4 3 0.004
Degrees of Freedom 37 - 3
Chi Squared Value for Fit 29.24653 -0.006 t .
Reduced Chi Squared Value  0.790447 Elapsed Time (<)
Excel File for 2500 Ch 11-JR.xls Project Report 1 11/23/2009
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Intermediate Lab
PHYS 3870

CONVEYIMG INFORMATION
Analyzing and Plotting Data with IGOR Pro

References:
PHYS 3870 Web Site
USU Library Class Web Site

IGOR Pro https://www.wavemetrics.com
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IGOR Pro Overview

IGOR Pro 6 is an extraordinarily powerful and extensible
scientific graphing, data analysis, image processing and
programming software tool for scientists and engineers.
It combines both a graphical interface for quick plotting
and a command line interface that can be easily used to
create script macros for repeated analysis of similar
data. The outputs are extremely versatile and of the -

highest publication quality. I I R

Angle of Incidence (degress)

Refer to https://www.wavemetrics.com/products/igorpro/lgor6Brochure.pdf for a
summary of the capabilities of IGORPro.

Additional information is available at https://www.wavemetrics.com/ .
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B

Program Installation

The USU Physics Department has a department Coursework License site IGOR Pro 6.3

The special coursework license is intended to facilitate the use of Igor as a teaching
tool and to introduce students to Igor under the following conditions:

» The software may be used only by students and only for assigned coursework. It may not
be used for research.

» All technical support must go through a single individual who is usually the instructor/
registered licensee.

* The license covers both Macintosh and Windows operating systems.

 Igor Pro can be installed on multiple computers. All that is required is that you make a
good-faith effort to ensure that the license is used for coursework only. The terms of the
license require that if they want to use Igor for research, they can purchase a student or
academic license.

+ WaveMetrics offers an inexpensive student personal purchase copy of IGOR Pro which
students can purchase with their own personal funds for their own personal work when their
use of IGOR extends beyond assigned coursework.

To install the software, please visit the Wavemetrics web page to download the latest

version of IGOR Pro 6.3 at https://www.wavemetrics.com/order/order igordownloads.htm
The activation information for our IGOR Pro license is available from the USU Physics Department.
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I G O R P r O WaveMe-I-riCS Technical graphing and data analysis software

. for scientists and engineers

. -
We b SI te | Home | | Products | | User Resources | | Support | | Order | | News | | Search |

Fito Smmian

Em”:!
I"l b o
mlwl W r.

| Confidnce Band g

Additional information is available COR XOP Toslkit

at the Wavemetrics web site IGOR Pro 6.3 New o o

https://www.wavemetrics.com/ LGOR Pro 6 Brochure merations, funcions,
(PDF, 4.4MB) menus, dialogs, and

windows for data

shown at right. _
B A IGOR PTO 6 is an extraordinarily :2:{}?:';{“’:35 B

- - - - Uurposes.
.. | Iggg{atpt release of . powerful and extensible scientific graphing, I{EDRPNIDWT e px
ro 15 Version b. o - - - ools
This is an excellent resource! data analysis, image processing and el Sl ey
The latest release of the programming software tool for scientists and into IGOR Pro.
Japanese version of IGOR engineers Supports data
Pro is 6.361. . acquisition devices

N made by National
The latest release of the See Details Try Now @ Buy Now Instruments.

XOP Toolkit is version

6.30. Macintosh and Windows Platforms IGOR Filter Design
Journal-quality scientific graphs Laboratory
LGOR NIDAQ Tools MX 3D and volume visualization Design FIR (Finite

Impulse Response)
and IIR (Infinite

Impulse Response)
filters and to apply
them to your data.

1.05 now available. Flexible image display
Handles large data sets very quickly
Extensive scientific and engineering data analysis
Curve fitting, peak fitting
Signal processing
Image processing and image analysis
Special support for evenly spaced data
« Completely programmable and customizable
The IGOR scientific graphing and data analysis program has

The latest release of IFDL
is version 4.02.

Contact WaveMetrics

Job Opportunities

Site map

been in active development since its introduction on Macintosh
Gallery in 1988.
News

IGOR Pro 65.36 released.

Intermediate 3870
UNIVERSITY Fall 2015
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IGOR Pro Tutorials

IGOR Pro offers excellent tutorials
accessed through the Help menu of
the program under Getting Started.

For PHYS 2500 the recommended

tutorials include:

* Introduction to IGOR Pro

* Guided Tour 1: General Tour (up to
Offsetting a Trace)

* Guided Tour 2: Data Analysis

The same material in the written
tutorials is available in video
(YouTube) format at the Wavemetrics

web site https://www.wavemetrics.com/.

There is an extensive manual
available in PDF format accessible
from the IGOR Pro Help menu.

This same menu offers:

* A Help Browser

» Explanation of shortcut key strokes
Command help

Example files

Access to excellent User Group
Wavemetric support (they actually

Tarhnienl Campifing for Selantists ana Froinases

Program Information and Tutorials

Wavemetrics provides exceptionally good help files and tutonials for use of [IGORPro. Begin by selecting
“Help™ from the IGORPro mem and then the “Getting Started™ tab (see below). The tutonals accessed at
the start of this document are a great next step. .

E-lgaerEJT-SP:HEm
File Edit DOata Analysis Macros Windows  Misc

£ Cetting Startedibt = ol ==
| Getting Started 5

n eazential intraduction

Thiz help file containg cvendew and guidad tour mataral and conEm
Pro. The main sections ara:

i lgor P

= Guided Towr 1 - Genesal To

- Gaided Tour 2 - Data Analysis Try these tutorials next.

= Guided Tour 3 - Histogrames and Cune Fifing

‘Wie stronghy recommend that you read at least the first two sections.

The rreaterial in this help file is dupicated in Volume | of the lgor Fro POF manual which is accessible
through The Halp manu

+ Introduction to Igor Pro

lgoris an integrated program for isualizing, analyzing, tansforming and presenting exgerimental data
lgors fealuras inchide

= Publication-guality graphics

= High-speed data display

= Ability 1o handle large data sets

= Curvefitting, Fourier transforms, smoothing, statistics and ather data anabysis

= Waveform anthmetic

= Image display &nd processing

= Comiination graghical and command-line user intarface

= Autcenation end data processing via 8 buik-in programming emaronment

= Extensibilty through modules writen in the C and C++ languagss

Some peopla usa kgor simply io produce high-qualty, finely-tuned scientdic graphics. Othars use gor as

an all-purpose workhorse to acquire, analyze and present experimental data using its buik-in
PIogramIming erironment. ¥ have tried towite the lgor program and this manual to fulfill the needs of
tha antire range of lgor users.

Getting Started

[gor Help Browser
Help Tapics
Shorteuts
Caommand Help
Se=nch Igor Files
Flarual

Support

Showw Igor Pro Folder
Shovw Igor Pro Liser Files

WavelMetnics Home Page
Support Web Page
[garfer hangm

License .
Abhout Coursework License , .

About Igor Pro..
Wpdates forlgor§.3.7.2

The IGORPro manuals and the Wavemetrics website http://www wavemetrics.com/ provide detailed

respond to your queries!)  formation | L this (sce below)

Intermediate 3870
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IGOR Pro TUtO”aIS Video Tutorials

Igor Pro Guided Tour

IGOR Pro OfferS exce”ent tUtOI’I&IS The Igor Pro Guided Tour is available in booklet form, as an Igor help file, in the Igor Pro PDF manual,

accessed through the and in the videos listed on this page.
Wavemetrics web site at To go through the tour by yourself, choose Help -> Getting Started in Igor or choose Help -> Manual

: t the PDF L
https://www.wavemetrics.com/. 0 open the PDF manua

To take the video tour, click the links below.

Guided Tour 1 - General Tour

For PHYS 2500 the recommended

video (YouTube) tutorials include:
* Introduction to IGOR Pro (Part of the
General Tour) (=13 min)

- Guided Tour 1: General Tour (Through e e o OR Pro
Video 2.1 and Video 3.0 (=30 min)
* Guided Tour 2: Data Analysis (~15 min) = IGOR Pro Guided Tour 1: 1.0 Launching IGOR

Pro

Igor Pro Guided Tour 1: 1.1 Entering Data

Igor Pro Guided Tour 1: 1.2 Making and
Touching Up a Graph

0s-

06~
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GOR Pro Manual

Volume | Getting Started
-1 Introduction to Igor Pro ... I-1
[-2  Guided Tour of Igor Pro ... I-11

Volume Il User’s Guide: Part 1
-1 Getting Help ..o I1-1
I[I-2 The Command Window ....... 11-19
II-3 Experiments, Files and Folders ...... o 11227
-4 WINdows oo 1I-53
II-5 0 WAVES oo II-75
-6 Multidimensional Waves ........cccooveoeeeciieiccrinenns 11-107
[I-7 Numeric and String Variables ... 1I-115
II-8 Data Folders ... 1-121
[I-9  Importing and Exporting Data ... II-139
[[-10 Dialog Features ... 1I-181
T-11 Tables ..o 11-189
[-12 Graphs oo 11-235
[I-13 Category Plots ... I1-315
II-14 Contour Plots ... I1-325
[I-15 Image Ploks ... 11-347
[I-16 Page Layouts ... 11-373

Volume lll User’s Guide: Part 2
-1 Notebooks .. II-1
IMI-2  Annotations ... I11-41
[MI-3 DIawing ..o esssennes I11-69
[MI-4 Embedding and Subwindows ........cccccoiinnees I11-87
[MI-5 Exporting Graphics (Macintosh) ... I11-99
[MI-6 Exporting Graphics (Windows) ... [I-107
M7 Analysis ..o I-115
-8 Curve Fitting ... II1-155
IM1-9  Signal Processing ... II1-235
[M1-10 Analysis of Functions ... II1-267
[1-11 Image Processing ... II1-297
TI-12 SEAtSHOS oot 1I1-329
I1-13 Procedure Windows ............c.iiiiinins II-341
[1-14 Controls and Control Panels ............................ I11-359
[I1-15 Platform-Related Issues ...............cococovieiiiieiies III-395
IMI-16 Miscellany ..o I-411
III-17 Preferences ... ccoecoeieeeeesieeeesessceeseemeesesnessesens I1-431

UtahState

UNIVERSITY

Intermediate 3870
Fall 2015

rableof Contrts IGOR PI‘O

Version 6.37
WaveMetrics, Inc.

Manual Revision: June 2, 2015 (6.37)
© Copyright 2015 WaveMetrics, Inc. All rights reserved.
Printed in the United States of America.

WaveMetrics, Inc.

PO Box 2088

Lake Oswego, OR 97035
usa

Voice:  506-620-3001

FAX:  506-620-6754

Email: support@wavemetrics.com, sales@wavemetrics.com
Web: httpyfwww wavemetrics. com/

http://www.wavemetrics.net/doc/igorman/ilgorMan.pdf

Volume IV Programming
IV-1 Working with Commands ... V-1
IV-2 Programming Overview ... IvV-19
IV-3 User-Defined Functions ..........ccccccceveiivivecrinnenns IV-25
IV-4 MACTOS oot cssiae s esens vV-99

IV-5 User-Defined Menus ............ e IN-109
IV-6 Interacting with the User ...

IV-7 Programming Techniques ... IV-147
IV-8 Debugging .......cccconcinrnann. v IV-187
IV-9 Dependencies ... V-203
IV-10 Advanced Programming ... IV-213

Volume V Reference
V-1 Igor Reference ... V-1
Index
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IGOR Pro

B Runs on Mac OS X and Windows

W Fast Display of Large Data Sets

B [nteractive Data Exploration

B Journal-Quality Graphics

B Powerful Curve Fitting

B Extensive Data Analysis & Statistics
B mage Processing

B Data Acquisition Support

B Built-In Programming Environment
Supports Analysis and Automation

B Customizable User Interface

B (Jsed by Scientists and Engineers
Worldwide Since 1989

WaveMetrics, INnc.
P.O. Box 2088

Lake Oswego, OR 97035
USA

Phone: 503.620.3001
Fax: 503.620.6754
sales@wavemetrics.com
www. wavemetrics.com

Technical Computing for Scientists and Engineers

Graphing

* Built-in graph types include highly
customizable X-Y plots, contour, image,
category, waterfall plots. Create interac-
tive 3D visualization graphics.

* Choose from 62 built-in marker symbols,
text markers (either a character or from
other data), arrow markers, error bars,17
dashed line types; customizable dashes.

* Specify marker color, marker size, or
marker type as functions of other data. 72
fill patterns, positive and negative fills,
fill between curves.

Interactively zoom and pan. Use cursors
toinspect data values.

Text annotations, legends, and color scale
bars. Use subscripts, superscripts, mixed
fonts and styles.

High resolution drawing tools.

Fully customizable andunlimited num-
bers of axes. Date and time axesin a wide
variety of formats.

Image FPlots

+ Image plotsfrom matrix and XYZ data.

« Display images using 58 built-in color
tables. Createindexed or custom color
tables. Limit colors toa range of data.

* Fully customizable color scale bars.

Contour Plots

¢ Automatic and user-defined, arbitrary
contour levels.

Color contours according tolevel, indexed

from data, or all the same.

Control contour label style, appearance,

andposition.

3D Visualization

 Create surface, 3D path, and ribbon plots,
3D scatter and object plots, iso-surface
voxelgrams and volume slices.

* Use the power of OpenGL to add trans-

parencies and textures.

Curve Fitting

Fit data using built-in and arbitrarily
complex user-defined functions with
unlimited independent variables and fit
parameters; fit to arbitrary subsets; hold
coefficients, using multiple threads.

* Apply weighting and linear constraints.

Levenberg-Marquardt method for nonlin-
ear fitting.

Orthogonal distance regression, errorsin
X, global analysis.

Built-in fits: linear, polynomial (1D & 2D),
exponential, double exponential, power
law, sine, gaussian (1D & 2D), lorentzian,
lognormal, Hill equation, sigmoid.

Outputs include parameter values, stan-
dard deviation and confidence intervals;
model curves; residuals; confidence
bands; covariance matrix; chi-square.

Presentation

Layouts

* Use page layouts to precisely arrange
graphs, tables, pictures, annotations, and
drawing elements for printing or export.

Notebooks

* IGOR Pro notebooks provide a built-in,
programmable word-processor; use them
to record experiment results using text,
tables and graphs.

Export

* Print at high resolution.

* Export high-resolution graphicsin EPS,
PDF, enhanced metafile, TIFF, PICT,
BMP, and PNG formats.

Analysis & Statistics

+ Single andmultidimensional mixed-radix
FFTg, continuous and chiscrete wavelet
transforms, Hilbert, Hough, Wigner and
Fast Gauss Transforms.

Smoothing (binomial, Savitzky-Go-
lay, box, median, Loess), integration,
differentiation, TR and FIR filtering,
convolution, ordinary differential ecqua-
tions, histograms, sorting, area, mean,
array arithmetic, windowing, peak and
level detection.

Full suite of matrix operations using
standard LAPACK routines.

Find function roots or extrema using
direct methods or simulated annealing.
Special functions and orthogonal polyno-
mials.

Probability distribution functions, cumu-
lative and inverse cumulative distribution
functions.

Statistical analysis including moments,
quantiles, correlations and serial random-
ness.

Statistical tests including ANOVA,
Bartlet, Cochran, Chi-squared, F, Jarque-
Bera, Kolmogorov-Smirnov, Levin,
Scheffe, t, and Tukey.

Statistical multi-comparison tests.

* Non-parametric hypothesis tests includ-
ing Friedman, Mann-K endal, Kruskal-
‘Wallis, Spearman and Wilcoxon’s.
Statistical analysis for angular data.
Random number generators for various
distributions.

Cluster analysis with K-means and
farthest-point algorithms.
Computational geometry including 2D
and 3D triangulation and interpolation.

Image Analysis

= Full suite of tools for image filtering,
manipulation, and quantification.

« Imagethresholding: iterated, bimodal,

adaptive, fuzzy entropy, and fuzzy means.

Operations for image arithmetic, arbitrary
non-contiguous region of interest (ROIy
masking, background removal, color
segmentation, windowing (Hanning,
Hamming, Bartlett, Blackman, K aiser),
blending, histograms, equalization, stack
focus, registration, rotation, statistics.
Particle analysis: number, area, perimeter,
circularity, rectangularity, location, raw
moments.

Image morphology: binary and grayscale
erosion, dilation, close, open, watershed,
tophat, seed fill.

Edge detection using canny, Frei, Kirsch,
Marr, Prewitt, Roberts, Shen, and Sobel
methods.

Image transformations include FFT Hart-
ley, Hough, convolution filters (gauss,
gradients, median, sharpen, thin, min
rank, max rank) color space conversions
(RGB, HSL, XYZ), derivatives, correla-
tions, extract and manipulate image data.

Image import and export using Quick-
Time technology: JPEG, PNG, PICT,
TIFF, BMP, QuickTime, Targa, Silicon
Graphics, PhotoShop.

Captureimages from live video.

Data Formats/ mport/ Export
Millions of data points; 1-4 dimensions.
Two floating-point and six integer for-
mats, strings, date andtime data.

Special support for waveform (equally-
spaced) data.

Handle files in general binary, delimited
text, Excel, Fortran fixed-field, FITS,
HDF5, JCAMP, MatLab, Nicolet, TDM,
TPEG, PICT, TIFF, BMP, Targa, Photo-
shop, SGI, Sun Raster, DEM, SDTS (and
other GIS) data formats, multi-channel
MP3, ATFF, and WAVE soundfiles.
Access SQL databases through ODBC.
Create and control QuickTime movies.
Data Browser — organize dataintoa
meaningful hierarchy, graphical previews
of data, view and edit wave and variable
properties.

Write your own procedures to import/ex-
port custom file formats, or move, copy,
and delete files and folders.

Extract data using regular expressions
(“grep”).

Data Acquisition

* Acquire data from instruments through
the serial port or through National Instru-
ments GPIB boards. Use the optional
NIDAQ Toolsto acquire data directly
from National Instruments boards.
Acquire data using VISA through GPIB,
serial port, TCP/IP, and other VISA-ca-
pable hardware.

For more information visit our web site at www.wavemetrics.com

* Create custom instrument user interfaces
and automate data collection, retrieval,
and analysis.

Programmability

A full-featured structured programming
language to control virtually all aspects
of IGOR Pro with over 965 built-in func-
tions and operations

Automate data analysis and acquisition
tasks.

Multi-processor and threading support
for built-in and user- defined routines.
Symbolic debugger.

« Create custom interfaces using control
panels with buttons, popup menus, lists,
sliders, inputs, outputs. Add your own
menus, completely or selectively replace
Igor’s built-in menus.

Scriptable via Appl eEvents, ActiveX
Automation, and DDE.

Documentation
« Complete IGOR Pro manual online in

fully-searchable, cross-referenced PDF
format.

Optional Packages

1GOR XOP Toolkit

¢ Enhance IGOR Pro’s capabilities with
external code modules by combining
your own C or C++ code with the IGOR.
XOP Toolkit’s source files.

¢ Create portable XOP modules for
yourself and others to add customized
functions, data loaders, data acquisition
systems, etc., with their own menus,
dialogs, and windows.

16OR NIDAQ Tools MX

¢ Acquire data directly into IGOR Pro
using National Instruments “multifunc-
tion” data acquisition boards.

1GOR Filter Design Lab

« Design. apply. and evaluate Finite and
Infinite Impulse Response (FIR and
IIR) filters in IGOR Pro.

FIR Filtersinclude Kaiser’s Maximum
Flatness design, McClellan-Parks-Rabi-
ner equiripple method, window method
design (Hanning, Kaiser, Parzen,
Welch, etc.).

TIR Filters include Bessel, Butterworth,
Chebyshev and Notch-only.

View magnitude, phase, group delay,
impulse, and step responses.

Apply designed filters to your data and
view the results.

See Igor6Brochure.pdf at https://www.wavemetrics.com/products/igorpro/lgor6Brochure.pdf
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Technical Computing for Scientists and Engineers

Enter data directly or import
< various data file formats

An IGOR Pro graph is a powerful tool for data

exploration, analysis and presentation \
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See Igor6Brochure.pdf at https://www.wavemetrics.com/products/igorpro/lgor6Brochure.pdf
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Example of Publication Quality Graphs with IGOR Pro

———T T T T T T T T T

T . . T . . T . T . . T T 00
= i
= Experiment 150
3 D,0 300K P 100
wl
g - 50
= L 1]

50
a0k g
=
gQU- g
]
= np g
] L 1 I

0400 0500 50600 30700 30300 50900
Ty Photon Energy (o™ )

Whale sharks diving behavior results
(©)
0=
0] ' l| il
‘ Y'I ;l “ o w | Angle of Incidence (degrees)
£ % O
2 » §
& 600 s ‘g (h)
1 . -
5 Comparison of two case studies
800 — 0 2
s
WO————T—7 71 7T T T T T T T T T I 1 P by
4 0y G SR 0D 0@ S O [17:15 170102 10 15:15 1840102
Date 3]
(a) y
500x10° o 2 i _JI\
c N /'_/' /_/" \ﬂ
L 400 39 _// | e I g .
g g0
5‘ 500 5 1+ (0409 2301102 1o 07:31 240102
PR 242n = . I
3 Dispersion surfaces of a rectangular lattice 2D — Nitrate
S photonic crystal. (a) first band, (b) second band, (c) 2 — Sulphate \\
-1 = Organics
third band . — \&\
hy
G T T T T T 1 0—= e e —— \"‘
0 1 2 3 4 5 L] i 3 4 5678 1 3 45878
Frequency (cydes per day) 10 100 1000
“Wacuum Aerodynamic Diameter (her)
Results from a recovered pop-up satellite archival tag attached to a 6 m male whale shark
(Rhincodon typus) off the Yucatan Peninsula, Mexico. Ambient temperature and depth data More exam ples at gfr?o%irr:seor:l %fatrft"'igl:anigssguci':csgfgﬁﬂﬁ: %"faggferg‘?s‘m;;ecsh‘ﬂ‘;fgr UK
recorded by the tag are shown for the entire 31-day track (top). The fast Fourier . i Aerod A | Mass Spect t !
transform-generated periodogram frem an analysis of these same fine-scale depth data https.//www.wave_metrl Hsing an Asrotyns Aerosel Mass Spactrometer.
are also demonstrated (bottom}. The high amplitude peak at 1 cycle per day is indicative cs.com/products/igorpr | JGeophys Res Atmos 108 (D3) 4090 & 4091 (2003) doi:10.1029/20027D002358
ignifi i i i i . & 10.1029/20021D002359
of a significant diel rhythm in the vertical movements of this shark o/qallerv/user.htm

UtahState

UNIVERSITY

Intermediate 3870
Fall 2015

WRITING REPORTS

Lecture 6 Slide 20



https://www.wavemetrics.com/products/igorpro/gallery/user.htm
https://www.wavemetrics.com/products/igorpro/gallery/user.htm
https://www.wavemetrics.com/products/igorpro/gallery/user.htm

Introduction to Scientific Computing
PHYS 3870

An Exercise in Analyzing and Plotting Data
with IGOR Pro

References:
PHYS 3870 Web Site
USU Library Class Web Site

IGOR Pro https://www.wavemetrics.com
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Introduction to Scientific Computing
PHYS 2500

An Exercise In Data Analysis
Using IGOR Pro

In the IGOR Pro plotting and curve fitting program:
* Import the data derived from the DataThief exercise from DennisonlinFreefall.jpg stored
in YOURNAMEInFreefall.txt.
* Import the data from FreefallLab.txt
* Do an automated fit with a quadratic model to the FreefallLab data.

» Create a single graph of position vs time with:
» Data points and error bars from FreefallLab.txt
 Data points from DennisoninFreefall.jpg
« A mathematical model for free fall plotted as a line
+ List your best estimates for values and errors for you model fitting parameters

» Create an IGOR Pro layout displaying the graph, data table and annotations exactly as
shown on the next page. Print the layout page as a pdf file.

» Save the IGOR Pro experiment.

« Submit the IGOR Pro experiment file (LastnameF|_IGOR.pxp) and the layout page
printout (LastnameFI|_IGOR.ppt).
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Data for An Exercise In Data Analysis
Using IGOR Pro

Freefall.txt
DennisoninFreefall.jpg

time(s) disp({m) error{m)
0 -137.5 145.9
3 0.06667 -157.6 145.2
o 0.1333 81.61 152.4
. 1.3=10 ' ' ' 0.2 62.14 151.9
= 0.2667 30.93 150.9
= 5 q 0.3333 81.17 152.4
2, 1x=10°F ¢ * 0.4 -12.04 149.6
- * 0.4667 258.4 157.8
= 0.5333  334.6 160
o L 0.6 398.2 161.9
= 5001 * & - 0.6667 218.3 156.5
= 0.7333 202.9 156.1
o * 0.8 524.1 165.7
[ > 0.8667 516.4 165.5
L o - 0.9333  268.2 161
.= p 1 672 170.2
3 1.067 527.9 165.8
| | | 1.133  656.7 169.7
— 500 1.2 1018 180.5
0 0.5 1 1.5 2 1.267 1004 180.1
1.333 1029 180.9
1.4 1128 183.8
: 1.467 1234 187
tme {5} 1.533 1412 192.4
1.6 1489 194.7
1.667 1264 190.9
1.733 1521 195.6
1.8 1049  208.5
1.867 2031  210.9
1.933 2016 210.5
2 2222  216.6
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JR Dennison
PHYS 2500
10/2f2015

IGOI'\;reF:farfgamExercise RESUItS fOI‘ An
Exercise In Data
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[|Fit to Quadratic Equation .
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I Xg =56541£57.2
o vg =220.83 £ 132
o ay =450.80 £ 64 »
e Using IGOR Pro
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Is C
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500 |~
o O Freefall data
C @® Scanned data
O%a = Quadiratic fit
T W R W AN TS TN TR T H T N |
0.0 0.5 1.0 15 2.0
Elapsed time (s)
Point time_s_ disp_m_ error_m_ Time2 Distance2
0 0 -137.5 145.9 0.00329 -148.5 = — 2
1 0.06667 -157.6 145.3 0.1998 -114.2 MO d el IS y(t)_at + Vot + Xo
2 0.1333 81.61 152.4 0.3926 65.95
3 0.2 62.14 151.9 0.5945 182.5
4 0.2667 30.93 150.9 0.798 534.7
5 0.3333 81.17 152.4 1.0018 531.7
6 0.4 -12.04 149.6 1.1945 812.8
7 0.4667 258.4 157.8 1.3948 634.1
8 0.5333 334.6 160 1.5965 934.0
9 0.6 398.2 161.9 1.7913 987.
10 0.6667 218.3 156.5 1.9895 1137.
11 0.7333 202.9 156.1
12 0.8 5241 165.7
13 0.8667 516.4 165.5
14 0.9333 368.3 161
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